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Introduction
How the course works

There are three sections:

1.	 Overview
2.	 Installation
3.	 Concepts

Beginners with no existing Joomla website should do the entire course.

Beginners who have had a Joomla website built for them and just need to 
learn how to use it can start at section 3, although section 1 provides a helpful 
overview.

Existing web developers can start at section 2, although section 1 provides a 
helpful overview.

Watching at full screen

The videos are in high definition and are best watched at full screen. To enable 
full screen mode, click the corresponding icon which is usually found at the 
bottom right of the video player.

Examples

To exit full screen mode, PRESS the ESC key at the top left of your keyboard.



What is Joomla?

•	 A website content management system
•	 Managed via a web browser
•	 Free
•	 Extendable
•	 Separated into the frontend and the Administrator (backend)

4 things to build a Joomla website

1.	 A basic understanding of how websites work
2.	 An understanding of how Joomla works
3.	 The Joomla software
4.	 An account with a web host

What can you do with Joomla?

•	 Build simple websites (text and images)
•	 Build specialist websites (e-commerce, membership, forums, blogs etc.)
•	 Build custom applications

Design Options

Joomla sites are powered by files that collectively are known as a template. There 
are free templates available as well as commercial templates. You can also engage a 
web designer to create a custom design that can be turned into a Joomla template.

Examples of Joomla-powered websites















Benefits of using a content management system

•	 The website is easy to update
•	 The website can be updated from anywhere in the world
•	 More than one person can update the site
•	 Design changes are easy
•	 No need to pay someone to keep site updated
•	 You control when the site is updated

Joomla Versions

Joomla version numbers can be confusing, but it is important to understand this as 
it affects your decision of which version to use. 



Major releases

•	 A new major version is released every two years.
•	 Joomla 3 was released in September 2012 and therefore the next major release 

is scheduled for September 2014.
•	 The first version number is the release number followed by .0 e.g. Joomla 3.0. 

Minor releases

•	 Minor versions are released every six months until the next major release
•	 The plan is to release three minor versions in between major releases e.g. 3.1, 

3.2 and 3.5.
•	 The .5 version is supported for two years (long term support)

Security/patch releases

•	 Additional versions are released if security flaws are discovered
•	 These releases get a third number in their version e.g. Joomla 3.0.1, 3.0.2, 3.0.3 

etc.

Recommendations

•	 If you don’t need any features that the new version offers, consider sticking 
with the most stable version in the previous release e.g. Joomla 2.5

•	 Before choosing a version, check to see that any required extensions are 
compatible

•	 Try to avoid the first version in a new release and wait six months for the next 
minor version e.g. Joomla 3.1



Chapter 2

Why Joomla?
Joomla Benefits

•	 Free
•	 Open source
•	 Cross platform
•	 Support
•	 Long history
•	 1000s of extensions
•	 Secure
•	 Popular
•	 Developer-friendly

Alternative Content Management Systems

Main contenders: WordPress and Drupal

WordPress

•	 Originally developed as a blogging platform
•	 Now considered a “real” content management system

Pros

•	 Easier to learn than Joomla
•	 Arguably easier to use than Joomla
•	 Initially more search engine friendly than Joomla

Cons

•	 Less page types than Joomla
•	 Plugins required to change sort order of articles, and hide features like the 

author name and published date
•	 Plugin required to assign content such as sidebar menus or footer text to 



specific pages

Although I prefer Joomla, WordPress is a great platform. WordPress tutorials are 
included in my Beyond the Basics training bundle.

Drupal

•	 Steeper learning curve
•	 More developer focussed
•	 Arguably better community

Website Builders

•	 Possibly suitable for basic sites that don’t need to change much
•	 Locked in to proprietary platform
•	 Inflexible

WordPress Backend
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Requirements
Web Hosting Requirements

•	 The majority of Joomla websites are hosted on Linux-powered servers
•	 The following specifications are the minimum requirements

Linux Hosting Requirements

•	 Apache version 2
•	 PHP version 5.3.1
•	 MySQL version 5.1

Windows Hosting Requirements

•	 IIS version 7
•	 PHP version 5.3.1
•	 MySQL version 5.1 or MSSQL 10.50.1600.1

Domain Name

•	 Your website needs a domain name. Its best to ask if your web host can obtain 
this for you as this provides a single contact for both your domain and website.

FTP Software

•	 FTP software provides a connection between your local computer and your 
website hosting account.

•	 The installation methods I demonstrate do not require you to use FTP software. 
However this is reliant on your web host providing a control panel that 
includes a File Manager. This is very common.

•	 In the event that you do not have the ability to upload the Joomla file to your 
hosting account and extract its contents, you will need FTP software. Filezilla is 
available for PC, Mac and Linux at https://filezilla-project.org



Section 2

Installation

4 - Joomla Demo Site
5 - Quick Install
6 - Standard Install



Chapter 4

Joomla Demo Site
demo.joomla.org

•	 Simple, no risk way to get started with Joomla
•	 Operated by CloudAccess.net - a Joomla specialist hosting company in the US
•	 At the end of the 30 day trial period you can:

•	 roll over to a paid account or 
•	 move the site you have created or
•	 walk away

•	 If you choose to turn your trial into a paid account, a portion of the fee is paid 
to Open Source Matters - the body that oversees the Joomla Project. So you get 
specialist Joomla hosting AND indirectly help Joomla. 

Getting Started

1.	 Enter your details at demo.joomla.org
2.	 In the Site Name box, ENTER a word that will become part of the web address 
3.	 Check your email and click the link to confirm the activation of your account
4.	 Access the demo site you created by navigating to the sub-domain you 

requested. Further details are contained in the welcome email sent to you by 
the demo site.

Note: it isn’t important which word you choose for Site Name. If you choose to 
continue with the site, you can ask CloudAccess.net to change this to a “real” 
domain name.



Joomla Demo Site
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Quick Install
This method is useful if your web host provides an auto-installer solution. This 
greatly simplifies the installation process. If this option is not available, you need to 
install Joomla manually as explained in the next chapter. The video for this lesson 
and the screenshots below were created using the cPanel control panel and the 
auto-installer called Softaculous.

Installing Joomla using an auto-installer

1.	 Login to your control panel using the details provided by your web host 

2.	 CLICK the auto-installer 
 



3.	 CLICK Joomla 
 

4.	 CLICK Install 

5.	 SELECT the version of Joomla to be installed (Joomla 3) 
 



6.	 CHOOSE the correct protocol 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.	 SELECT the appropriate domain name 
 



8.	 ENTER the correct In Directory location (optional - only use if you are 
installing Joomla in a directory other than root) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.	 LEAVE the default database name as is unless you have a specific reason to 
change it and you know what you are doing 
 
 
 
 
 
 
 
 
 



10.	 ENTER a name for your site and a description. These can be changed at a later 
date 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.	 LEAVE database settings at the default as well unless you have a specific 
reason to change them and know what you are doing 
 



12.	 CHANGE the default Admin Username from admin to something more 
secure
13.	 DECIDE whether or not to use the auto generated password. If you 
decide to change it, you can either click the key icon to randomly generate a new 
password, or you can enter your own in the text box.
14.	 ENTER your name in the Real Name box as well as an email address that 
Joomla will use to send email notifications
15.	 RECORD your Admin Username and Admin Password if necessary as you 
will need these to access the Joomla Administrator. COMPLETE the installation by 
clicking the Install button. 
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Standard Install
This chapter is only necessary if you have not yet installed Joomla and your web 
host does not offer a quick install solution or you have chosen to install Joomla 
manually. There are four basic steps to installing Joomla at a web host using a 
control panel, and we will go through these steps for the most widely available 
control panel, cPanel.

Installing Joomla using cPanel

Get the Joomla file. 



Create a Database
1.	 Login to your control panel using the details provided by your web host
2.	 Click MySQL Database Wizard 

 
 
 
 
 
 
 
 
 

3.	 ENTER a name for the database and CLICK Next Step 
 



4.	 ENTER a username for the database and note that the maximum number of 
characters is 7

5.	 ENTER a password for the database user twice - make sure to remember it as 
you will need it in the following installation process

6.	 CLICK the Create User button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.	 CLICK the Next Step button on the following page - leave all boxes checked 
 
 
 



8.	 MAKE a note of the following information
a.	 The Database Name - note that cPanel adds a prefix to the word you entered. 

The cPanel prefix is the name of your account with an underscore. So, in this 
example the name of the database is joomlav5_testdb.

b.	 The Database User - The same prefix is added to the user, for example 
joomlav5_user.

c.	 The Database Password that you entered previously.
d.	The MySQL username, which will be localhost. 

Upload and Extract Joomla File
You will now copy the Joomla file that you downloaded in step 1 into your hosting 
account. This can be done with FTP software, or you can use cPanel as shown here.

1.	 Log in to your control panel with the details provided by your web host
2.	 CLICK the File Manager icon 

 
 
 
 
 
 
 
 
 

3.	 SELECT the default option - web root - and CLICK Go 
 
 



4.	 CLICK the Upload button 
 
 
 
 
 
 
 
 
 

5.	 CLICK the Browse button in the new window that opens and then navigate to 
the Joomla file you saved to your computer earlier 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.	 CLICK the Back link to return to the file listing 
 



7.	 CLICK the Joomla file name in the file listing so that it becomes highlighted
8.	 CLICK the Extract icon at the top of the page 

 
 
 
 
 
 
 
 
 
 
 
 

9.	 CLICK the Extract button on the pop up window 
 



10.	 CLICK the Close button once the extraction process has completed 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.	 DELETE the original Joomla zip file to save space on your server 
 



Joomla Web Installer
The next step to completing your Joomla installation is working through the 
Joomla Web Installer. This is the same process no matter which control panel you 
are using.

1.	 NAVIGATE to your web address. If you have placed your Joomla installation 
into a sub folder, NAVIGATE to your web address followed by a slash and 
then the name of the folder that you created. You should now see the Joomla 
web installer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 ENTER a name for your site. Leave the description blank if you intend on 
creating a unique meta description for each page, which is the recommended 
method for good SEO. 
 



3.	 ENTER an email address that will be used for the site.
4.	 ENTER a username that will be used to access the backend Administrator. 

Choose something other than “admin”.
5.	 ENTER a strong password twice.
6.	 CLICK Next 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



7.	 LEAVE Database Type set to MySQLi unless you know it needs a different 
setting. If you have issues with the installation completing, you can try setting 
this to MySQL.

8.	 LEAVE Host Name set to localhost unless you know this needs a different 
setting

9.	 ENTER the Username for your database, including the required prefix if 
necessary, that you set earlier in the installation process

10.	 ENTER the Password for your database
11.	 ENTER the Database Name, again remembering to include any necessary 

prefix 
 



12.	 LEAVE the Table Prefix information as it is
13.	 LEAVE the Old Database Process as it is unless you know what you’re doing 

and need this set differently 
 
 
 
 
 
 
 
 
 
 
 
 

14.	 CLICK the Next button at the top right 
 



15.	 SELECT “Learn Joomla” sample data
16.	 LEAVE Email Configuration set to No unless you want the configuration 

information sent to you by email. Be aware of the potential security issues of 
sending this information over email. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



17.	 CHECK that all settings under Pre-Installation Check are green Yes icons 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

18.	 CLICK install 
 



19.	 CLICK Remove installation folder button to remove the installation files from 
your hosting account

20.	 VISIT the frontend or backend Administrator by clicking the respective button 
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Frontend

Frontend vs. Backend
The frontend of a Joomla website is what you see when you load your web 
address into a browser, such as Firefox, Chrome or Internet Explorer. This view, 
together with the backend Administrator that will be covered next, is what 
was created when you went through the Joomla installation process. While the 
backend Administrator provides an easy method for website administration and 
development, the frontend is the view that is presented to an end user, or website 
visitor.



Files and Folders
Joomla provides a layer of abstraction for the inner workings of the website, 
meaning that an administrator does not need to know how to maintain or change 
individual files in order to update a website. It is still beneficial to get a glimpse 
of what files and folders exist. You may even need to access a folder such as the 
Images folder at some time. You can see in the image below what some of the 
folder structure looks like. This is taken from the cPanel file manager. 
 



Template Overview
All Joomla websites are driven by a Template. Joomla will use a default Template 
unless you install and enable another one. When choosing a Template, make sure 
to consider the actual design as well as the the Template positions.

All Joomla Templates feature positions that control various locations on the 
web page. Here is an example of a few of the positions for the default Joomla 3 
Template, Protostar.

Find some great suggestions for Joomla Templates at: 

www.buildajoomlawebsite.com/resources/templates.

http://www.buildajoomlawebsite.com/resources/templates


Primary vs. Secondary Content
Content that appears on a web page can often be divided into two categories; 
primary content and secondary content. Primary content is the main article or 
articles that normally appear in the middle of the page. Everything else on a web 
page can be referred to as secondary content, and in Joomla this content is usually 
displayed through the use of Modules.
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Administrator

Accesssing Administrator
Now that you understand the difference between the frontend and the backend, 
we’ll look at how to access and use the Joomla Administrator.

1.	 NAVIGATE to your web address followed by /administrator
2.	 LOGIN using the site login details you set during installation 

 



Review Messages
When you first access your Control Panel in Joomla, you may see a notification that 
you have messages to review, and possibly a message that an update is available. 
In order to dismiss the message notification, you need to access and hide those 
messages.

1.	 CLICK Review Messages button 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 CLICK Hide Message button once you have reviewed each message 
 



Administrator Workspace
There are four main sections of the Administrator Workspace. They are noted 
below.
1.	 Navigation Menu providing access to core Joomla Administrator pages
2.	 Title bar showing your current position within Administrator
3.	 Left panel providing shortcuts to other sections in Administrator - this is 

relative to your current position
4.	 Main content area 

 



Main Administrator Sections

System Menu

The most important links under the System menu are Control Panel which takes 
you back to the initial screen that displays when you first log in, and the Global 
Configuration section which allows you to set all of the main settings for your site.

Users Menu

The User menu is where you can create users for your site and manage the Access 
Control Lists for creating rules about who can do and see what on your website. 
This applies to both the frontend and the Administrator.

Menus Menu

The Menus menu allows you to create the pages for your website based on the 
content you create through the Article Manager and other Extensions.



Content Menu

The Content menu holds the menus that allow you to manage the content on your 
site. The Article Manager and the Category Manager are found here. The Media 
Manager, which controls image and video uploads, is also found here.

Components and Extensions Menus

The Components menu holds the links to installed pieces of software that provide 
functionality on your Joomla website. You’ll find Joomla core Components, such as 
Banners and Joomla Update, as well as third party installed Components, such as 
Akeeba Backup and JCE.

The Extensions menu provides links to all of the other types of Extenions within 
Joomla, such as Modules, Plugins, Templates and Languages.

Help Menu

The Help menu provides links to various Joomla help sites, such as the Official 
Joomla Support Forum, the Joomla Extensions Directory and others.



Current User Menu

In the top right corner of the menu bar is a gear icon that provides links to manage 
aspects of the currently logged in user. You can edit your own account from here as 
well as log out of the system.
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Categories
This is the chapter where you start to create your actual website content. There 
are two steps to creating most new content in Joomla. First you create one or more 
Categories, which is described in this chapter, and then you create Articles which 
we will discuss in the next chapter.

Joomla provides a very flexible method of categorizing and storing content. The 
storage system can be compared somewhat to folders and the files that go inside. 
With Joomla you are creating Categories that act like folders to store the Articles 
that you create, which are like the files in this analogy. You can also nest Categories 
in Joomla just like you can nest folders on your computer. Be careful not to create 
an overly complicated Category structure however. Keep things simple where you 
can.



Creating New Categories
The first step to creating new content should be the creation of at least one 
Category.

1.	 NAVIGATE to the Content menu and then Category Manager 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 CLICK New



3.	 ENTER a Title for the new Category 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.	 SELECT a Parent Category if necessary 
 



5.	 CLICK Save & Close 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Editing Categories
If you need to edit existing Categories, you follow a similar workflow to creating 
them.

1.	 NAVIGATE to the Content menu and then Category Manager



2.	 CLICK the title of the Category that you wish to edit 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 MAKE your changes and CLICK Save & Close 
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Articles
In this chapter you will learn the second part to creating primary content - creating 
Joomla Articles. You will also learn to search for and filter Articles in the Joomla 
Administrator.

Creating Articles
Begin by loging in to the Joomla Administrator as previously shown.

1.	 NAVIGATE to the Content menu and then Article Manager 
 



2.	 CLICK New 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 ENTER a Title 
 



4.	 SELECT a Category at the right of the page 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.	 ENTER your content into the main window of the editor 
 



6.	 FORMAT your content - this step is optional and will be covered in later 
chapters

7.	 CLICK Save & Close 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Search and Filter
You can control how many Articles are shown in the list by selecting a number 
from the Display drop down in the top right of the page as shown. By default, 20 
Articles are shown. 
 



As your site grows and you have more Articles to manage, you will need to 
utilize some of the other filtering features provided by Joomla. At the top of the 
Article Manager page is a Search box. You can search through all of the Articles by 
entering Titles or even parts of Titles in the box. Clear the box by clicking the Clear 
button when you are done filtering.

There are also various other filtering options, and these can be shown or hidden 
by clicking the Search tools button as shown below. Once they are visible, you can 
select several options such as the Status of an Article, the Author of an Article or the 
Category that the Article is stored in.



Ready to take the next step?
Beyond the Basics demonstrates every Joomla feature 
as well as search engine optimisation, ecommerce, 

membership sites and much more.

Visit www.buildajoomlawebsite.com and look for 
Tutorials > Beyond the Basics.

http://www.buildajoomlawebsite.com
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Menus
The displaying of content in Joomla is a bit different than traditional web design. 
In a Joomla website, Menus are used to create pages and specify how the content 
appears on the page.

Adding a Menu Item to an Existing Menu
We will add a Menu Item to the Main Menu on the sample Joomla site that was 
created earlier in the Joomla installation. The new link will display on the following 
menu. Begin by signing in to your Joomla Administrator as explained previously.



1.	 NAVIGATE to the Menus menu and then select the Main Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 CLICK the New button 
 



3.	 ENTER the Menu Title that will become the actual link text on the frontend
4.	 CLICK the Select button next to Menu Item Type 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.	 SELECT Articles and then Single Article in the pop up window that displays 
 



6.	 CLICK the Select button next to Select Article 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.	 CLICK the title of the Article that you wish to display from this new Menu 
Item link. Note that you can filter the results by searching all or part of the 
Article title in the Filter box at the top of the pop up as shown. 
 



8.	 CLICK Save & Close 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.	 CHECK the frontend to ensure that your link is displayed 
 



Creating a Menu from Scratch
The second method we will discuss is creating a new Menu from scratch. Again, 
begin by signing in the Joomla Administrator.

1.	 NAVIGATE to the Menus menu and select Menu Manager 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 CLICK the New button 
 



3.	 ENTER a Title for your new Menu
4.	 ENTER a Menu type with no spaces. This is just an internal reference used by 

the Joomla system. It is not displayed on the frontend.
5.	 ENTER a Description for your Menu. This is useful if you have many Menus 

and need to keep track of what each one is used for.
6.	 CLICK Save & Close 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The next step is to create a new Menu Item in this Menu exactly as described in the 
previous steps, “Adding a Menu Item to an Existing Menu” at the beginning of this 
chapter. Follow those steps to create a new Menu Item in your new Menu.

The new Menu is now created and complete; however, nothing will be changed or 
added to the frontend until a new Module is created and associated with this new 
Menu. This process is explained in the Modules chapter, which is next.
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Modules

Understanding Modules
As you’ve learned in previous chapters, website content can be broken up into two 
parts: primary content and secondary content. You learned how to create primary 
content in the Articles chapter and how to link to that content in the Menus 
chapter. Other content on the page, such as navigation menus, newsletter signup 
forms or footer text is secondary content. In Joomla, this secondary content is 
normally controlled through Modules.

Modules are one of the five types of Joomla Extensions. The other types are more 
fully explained in chapter 15.

Creating a Menu Module
Once a Menu has been created, it is displayed on the frontend by creating a Menu 
Module. As usual, begin by signing in to the Joomla Administrator.

1.	 NAVIGATE to the Extensions menu and select Module Manager 
 



2.	 CLICK the New button 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 SELECT the Menu listing from the options that display 
 



4.	 ENTER a Title for the Menu Module
5.	 SELECT the appropriate menu to be displayed from the Select Menu 

dropdown 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.	 SELECT the Template Position to display the Module from the Position 
dropdown in the right side of the page 
 



7.	 CLICK Save & Close 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.	 CHECK the frontend to ensure that your new Menu is displaying properly 
 



 
 
 
 
 
 
 
 
 
 

Now that you’ve seen exactly how to create a specific type of Module, you should 
be able to create almost any type available to you. Here is a recap of the general 
steps to creating a new Module:

1.	 CLICK the New button in the Module Manager screen
2.	 CHOOSE the Module type
3.	 ENTER a Module Title
4.	 SELECT a Template Position to display the new Module
5.	 ENTER any other applicable settings or content for the Module
6.	 SAVE the Module and CHECK the frontend by refreshing your browser

Assigning Modules to Menu Items
Modules can be set to display on all pages throughout the site, or just pages that 
you specify. First, as always, sign in to the Administrator.

1.	 NAVIGATE to the Extensions menu and select Module Manager 
 

Template positions are determined by the 
template developer. Templates usually have 
a map that displays the available position 
names. For the sample template that comes 
with Joomla and is used in this course, find 
the module map in the appendix section of 
this workbook.



2.	 CLICK the Title of the Module you wish to work with 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 CLICK the Menu Assignment tab
4.	 SELECT Only on the pages selected from the Module Assignment dropdown 

 



5.	 CLICK the None link next to Select at the top of the Menu Selection screen in 
order to clear the pages that will be displayed. This will cause the Module to 
not be displayed on any pages, but it will also make selecting the page or pages 
where you want to display the Module easier to manage.

6.	 CLICK the None link next to Expand in order to collapse the list and make it 
easier to see all of the available Menus 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.	 CLICK the plus sign next to Main Menu in order to view the options under 
that Menu

8.	 SELECT the Menu Item “pages” that you would like your Module to display 
on 
 



9.	 CLICK Save & Close 
 
 
 
 
 
 
 
 
 
 
 

10.	 CHECK the frontend to ensure that your Module is displaying properly

Module Order
The last issue that we will consider in this chapter is the ordering of Modules on 
the page. We can change the order that Modules display by setting the Ordering 
column in the Module Manager.

As it is now, the Menu Module created in this chapter is at the top of the Right 
sidebar. We will go through the required steps to change that ordering. As always, 
begin by signing in to Administrator.

1.	 FILTER the Modules by Position with the Select Position dropdown. We’re 
working with the Right sidebar, which is position-7. 
 



2.	 CLICK the double arrow icon at the beginning of the row of listings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 GRAB the ordering icon to the left of the Module that you would like to re-
order and drag it to the new location in the list 
 



4.	 CHECK the frontend of your site to ensure that the Module has been re-
ordered 
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Images
The Joomla Media Manager is used to add images to Articles and Modules, and 
can be accessed in different ways. In this chapter we will go over how to add 
images to your content, the importance of resizing them and how to upload them 
through the Media Manager.

Resizing Images
It’s very important to understand the concept of image sizing when it comes to 
content on a web page. Many of the images available, whether from a modern 
digital camera or online services, are quite large in terms of physical file size and 
the size that they take up on the screen. If you are new to this concept, understand 
that large images can annoy visitors by taking a long time to load and also hurt the 
performance and display of your website as well.

If you already have a prefered method of working with images, great. If you don’t, 
check the appendix section of this workbook for some information on resizing 
images with a service called PicMonkey.

Adding Images to an Article or Module
After deciding where to place your image and adjusting it for file size and pixel 
size, follow these steps to include your image in your content. Make sure you are 
signed in to Administrator.

1.	 FIND the Article previously created by searching its Title in Article Manager 
 



2.	 CLICK the Article’s title to edit it and POSITION your cursor on an empty line, 
which may require you to enter a new line at the top of the Article text

3.	 CLICK the Image button underneath the editor window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.	 CLICK the Browse button and navigate to an image on your computer to 
upload to your website

5.	 CLICK the Start Upload button once you have selected your image to upload 
 
 



6.	 CLICK the newly uploaded image in the directory window and notice that its 
filename is added to the Image URL field 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.	 CLICK the Insert button at the top right of the popup window 
 
 
 



8.	 CLICK Save & Close after checking your Article’s content to make sure the 
image was placed correctly 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.	 CHECK the frontend of your website to ensure that your Article is displaying 
properly 
 



To add an image alongside your text rather than above it, follow these steps. We 
will use the already uploaded image and begin from the Article editing step.

1.	 POSITION your cursor directly to the left of your text
2.	 CLICK the Image button beneath the editor window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.	 FOLLOW the same steps to select an image for your Article, but this time set 
Image Float to Left or Right. 
 



4.	 CLICK Insert, then CLICK Save & Close in your Article as before
5.	 REFRESH the frontend of your site to check the Article. Notice that the text 

now wraps around the image. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Media Manager
Joomla’s Media Manager enables you to upload, store and delete images and other 
media files in a similar way to using an FTP program. If you are more used to 
using FTP, continue to use that, but you should also understand how the Media 
Manager works.

1.	 NAVIGATE to Content Menu and then Media Manager 
 



Navigation and Folder Management

To move between folders, you can utilize the left sidebar folder tree in much the 
same way you do on a home computer. You can also click the icons for the folders 
in the center of the page as shown. The icon with the up arrow will take you to the 
folder directly above your current location.

The Create New Folder button will toggle the fields that allow you to create a new 
folder based on your current location. If you are in the banners folder for instance, 
your new folder would be located at /home/yourdomain/public_html/images/
banners/newfolder on your server. You can see the folder path in the window just 
above the folder icons in the middle of the page.

Clicking the checkbox next to a file and then clicking the Delete button will remove 
those files from the server. This action will work as well with folders; however, the 
folder must be empty before it is deleted. You can remove multiple files or empty 
folders at once using this method. The X in the top right of the file or folder icon 
can be used to delete one at a time.



File Uploads

The Media Manager also allows single and multiple file uploads. Clicking the 
green Upload button will toggle the Browse and Start Upload buttons that enable 
you to navigate your computer files to select single or multiple files for direct 
upload to your server. As with folder creation, file uploads are dependent upon 
your current location, so make sure you are in the folder where you want to place 
your images on upload. Once your files have been selected through the Browse 
button, simply click Start Upload to begin the upload process.
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Templates

One great aspect of Joomla is that there is a wide range of Templates available, 
and if you are a designer or developer, you can create your own. It’s also very 
possible to find someone to create one for you since Joomla uses widely accepted 
technologies in its construction.

The Template Manager
Joomla Templates are technically a type of Extension, and they are managed in the 
Template Manager in Administrator underneath the Extensions Menu.

You can manage a specific Template by clicking on its name in the list. You can also 
set the Default template, or the Template that Joomla will use for displaying your 
site, by clicking the star icon in the Default column. The current Default Template 
is shown with a gold star.



Finding Templates
There are hundreds of off the shelf Templates available for Joomla. Some are free, 
but the better designs are commercial, and you can expect to pay between $30 and 
$80 per Template.

A google search for Joomla 3 Template will provide many results, and you can also 
find a list of our recommended Templates in the Resources section of our website.

www.buildajoomlawebsite.com/resources/templates

Installing Templates
There are three common methods to installing Templates in Joomla. 
1.	 Installing a Quickstart Package
2.	 Installing the Template on its own
3.	 Installing the Template along with supporting files

Quickstart Installation

The Quickstart installation is very similar to a normal Joomla installation. The main 
differences are that you download the file from a third party Joomla developer 
and during the installation you must choose to install the demo content, this is not 
optional. What you end up with is an exact replica of the developers demo on their 
website.

Most Template developers do provide some kind of Quickstart installation, but 
make sure that they do if you have any questions.

We will skip this installation method here since the process is so similar to the 
Joomla installation method already described.

Installing a Template Into an Existing Joomla Installation
We will go through the process of installing a Joomla Template into an existing 
installation. Make sure you are signed in to Administrator.

We will be installing a Template called JA Purity II from JoomlArt.

http://www.buildajoomlawebsite.com/resources/templates


1.	 DOWNLOAD the Template files by selecting the following three files 
 
Navigate to http://www.joomlart.com/forums/downloads.php?do=cat&id=402 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 UNZIP the downloaded file to access the individual files inside
3.	 NAVIGATE to Extensions --> Extension Manager in Joomla Administrator
4.	 CLICK Browse to locate the JA Purity Template file on your computer
5.	 CLICK Upload & Install to install the Template 

 

http://www.joomlart.com/forums/downloads.php?do=cat&id=402 


6.	 REPEAT steps 4 and 5 for the other two files downloaded with the Template 
file

7.	 NAVIGATE to Extensions --> Template Manager
8.	 CLICK the star icon next to the ja purity title to set it as Default 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.	 REFRESH the frontend of your site to check that the Template has changed 
 
 



There are often many different settings that are available with a new Template, and 
because this is open source software, it isn’t always the same for each developer. 
Make sure to read through the documentation available for the Template that you 
are installing so you know what features are available to you.

There is a documentation link available for JA Purity on the following page:
 http://www.joomlart.com/joomla/templates/ja-purity-ii 

http://www.joomlart.com/joomla/templates/ja-purity-ii
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Extensions
Joomla provides all the functionality you need for a simple site, but if you require 
some specific functionality you can often find what you need with an Extension 
from a third party developer. There are thousands of these Extensions, some of 
which are free, while others are sold for anything between a few dollars and a 
couple of hundred dollars. As Joomla is open source and written using the popular 
PHP language, it’s also possible to write your own Extensions if you have those 
skills, or you can find a developer to do this for you.

The Five Types of Extensions

Components

You can think of Components as applications. These often provide complex 
functionality. Examples of Components include image galleries, online shopping 
carts and membership sites. These are often quite complex and require that you 
carefully read the supplied documentation.

Modules

We have already explored Modules back in lesson 12. As you know, they are 
managed through the Module Manager and provide a way to manage and display 
secondary content on your website. Examples of Modules are navigation menus, 
search boxes and registration forms.

Plugins

As their name suggests, Plugins add content or functionality to a page or content 
item. Some Plugins work in the background of a page and can add additional code, 
such as Google Analytics tracking. Other Plugins may be activated within a specific 
type of Article or Module, for instance to provide commenting to an Article.



Templates

You are also already familiar with Templates, which provide different layouts for a 
website and are managed through the Template Manager.

Languages

There are two considerations when it comes to multilingual Joomla websites. 
The first is the default text that Joomla outputs in various places. The Language 
Manager page in Administrator allows you to install language packs and change 
the default language of the site. The second consideration for multilingual sites is 
creating versions of each content item for each required language and setting the 
site up to allow visitors to display their desired language. This is an advanced topic 
that is not covered in this course.

Finding and Choosing Extensions
The majority of Joomla extensions are listed on the Joomla Extensions Directory at 
extensions.joomla.org.

You can navigate through the site using either the search bar in the top of the page 
or the sidebar Categories to the left.

http://extensions.joomla.org


What to Consider When Choosing Extensions

1.	 Compatibility with your current version of Joomla. Each listing will have one 
or more icons showing what versions of Joomla it is compatible with. Pay close 
attention to this as the wrong version of an Extension can cause your site to 
stop working.

2.	 Community Ratings and Reviews. These can tell you a lot about the quality of 
both the Extension itself as well as its developer. If there are many bad reviews 
stating that support is poor, you may want to skip that one.

3.	 Commercial (paid) vs. Non-Commercial (free). Some free software on the JED 
(Joomla Extension Directory) is excellent. However, there are times where paid 
Extensions have better support and more extensive development and testing. 
Weigh your budget along with the other two issues above.

Installing Extensions
You’re already familiar with the process of installing Extensions from the 
Templates chapter. Installing any Extension will follow the same steps.

Remember, the process of installing and configuring Extensions varies depending 
on whether or not you need to extract some files first. So it’s always a good idea to 
read the documentation from the developer. 

The basic process is:

1.	 Find a suitable solution
2.	 Download the files
3.	 Possibly extract the contents of the download
4.	 Install the Extension
5.	 Configure the Extension
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Conclusion
Well, congratulations on choosing to learn Joomla the fast and easy way. You now 
know everything necessary to build a basic Joomla website, but this is just the start 
of your Joomla journey.

Recommended Joomla Sites
Right now, you probably want to get started, but at some stage you’ll almost 
certainly need some help. So here are some great ways to make your Joomla 
journey more comfortable. The best place to get help is the Joomla forum at forum.
joomla.org. This contains literally millions of posts so there is a good chance that 
your question has already been answered.

The next place to visit is the Extensions Directory mentioned in the previous lesson 
at extensions.joomla.org.

Another section at Joomla to check out is the Resources Directory and you’ll 
find this at resources.joomla.org. This includes contact details for third 
party organisations that provide Joomla services such as Templates, hosting, 
development and support.

Finally, have a look under the “Community” menu and you’ll find a link to 
“Joomla! User Groups” where you might find a group of Joomla people in your 
local area. This is a great way to accelerate your learning as you network with like-
minded people who can help you overcome challenges. The community pages also 
include the Joomla Magazine which is full of Joomla news and advice.

http://forum.joomla.org
http://forum.joomla.org
http://extensions.joomla.org
http://resources.joomla.org


Build a Joomla Website
We have a bunch of ways to help you too, so if you’re not there already, please 
visit us at www.buildajoomlawebsite.com. We run our own forum which is tiny 
compared to the Joomla forum, but it is another great way to get help as both 
myself, our team and other students regularly visit to help out beginners and 
experienced developers alike. This is also a great place to bounce around ideas, and 
our paid members have a special area where we guarantee that every question gets 
answered.

Also check out our blog and newsletter which contains even more tutorials, news, 
interviews, contests and as much information as we can gather to improve your 
Joomla experience.

And finally please consider our advanced Joomla tutorials. Our Beyond the Basics 
course takes you…well…beyond the basics of this course. The main course in this 
bundle is a six hour course called How to Build a Joomla 3 Website from scratch. 
This takes you through every step from understanding websites, choosing a 
domain name and website planning through advanced ways of creating primary 
and secondary content as well as using popular Extensions. 

The bundle also includes courses on all the features of Joomla, search engine 
optimisation, forms, email marketing, ecommerce, membership sites and a whole 
lot more. With over 150 lessons and more being added all the time, Beyond the 
Basics is a fantastic value. It’s not a subscription, and you get lifetime access, 
lifetime updates, lifetime support and a lifetime guarantee.

Well, I hope you’ve learnt a lot from this free course. You might like to head to our 
forum now and write a post in the introduction category so I can say “Hi.” I look 
forward to seeing your first Joomla website. 

Bye for now.
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